
Quickstart for GitHub Copilot 
 

GitHub Copilot can help you work, by offering inline suggestions as you code. 

GitHub Copilot can be managed through personal accounts with GitHub Copilot for Individuals or through 
organization accounts with GitHub Copilot for Business. 
 
GitHub Copilot is free to use for verified students, teachers, and maintainers of popular open source projects. If you 
are not a student, teacher, or maintainer of a popular open source project, you can try GitHub Copilot for free with a 
one-time 30-day trial. After the free trial, you will need a paid subscription for continued use. For more information, 
see "About billing for GitHub Copilot." 

Introduction 
GitHub Copilot is an AI pair programmer. You can use GitHub Copilot to get suggestions for whole 
lines or entire functions right inside your editor. 

This guide will show you how to set up a GitHub Copilot subscription for your personal or 
organization account, install the GitHub Copilot extension in Visual Studio Code, and get your first 
suggestion. For more information on GitHub Copilot, see "About GitHub Copilot for Individuals." For 
more in-depth information on how to use GitHub Copilot in a variety of environments, see "Getting 
started with GitHub Copilot." 

Signing up for GitHub Copilot for your personal account 
Before you can start using GitHub Copilot, you will need to set up a free trial or subscription for your 
personal account. 

Note: If you were part of the free GitHub Copilot technical preview that was run between July 2021 and June 2022, you are not eligible 
for a 30-day trial. 

1. In the upper-right corner of any page, click your profile photo, then click Settings. 
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2. In the "Code, planning, and automation" section of the sidebar, click  GitHub Copilot. 
3. On the GitHub Copilot settings page, click Enable GitHub Copilot. 
4. Choose whether you want to pay monthly or yearly, and click Continue to get access to 

Copilot. 
o If your personal account meets the criteria for a free GitHub Copilot subscription instead 

of a trial or paid subscription, you will automatically be taken to step 6. 
5. Follow the steps to confirm your payment details, then click Submit. 
6. Select your preferences, then click Save and get started. 

You can change these preferences at a later time by returning to your GitHub Copilot settings. 
For more information, see "Configuring GitHub Copilot in your environment." 

Note: As a member of an organization owned by a GitHub Enterprise Cloud account with a GitHub Copilot subscription, you must be 
assigned a GitHub Copilot seat by your organization before you can use GitHub Copilot. 

Signing up for GitHub Copilot for your organization account 
Before you can start using GitHub Copilot in your organization account, you will need to set up a 
subscription. 

1. Go to the GitHub Copilot for Business sign up page. 
2. Select an organization for which you want to purchase GitHub Copilot and click Continue. 
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3. Follow the steps to confirm your payment details, then click Save. 

If you don't have a payment method on file, you'll be prompted to add one. 

4. In the "Public code suggestions" dropdown, select Allow or Block to allow or block 
suggestions that match public code, and click Save and continue. You can change these 
preferences later by returning to your GitHub Copilot settings. 

5. Either grant access to GitHub Copilot for all current and future users in your organization, or 
for specific users in your organization. 

o If you selected Allow for all members, click Confirm in the "Confirm seat assignment" 
dialog to confirm that you want to enable GitHub Copilot for all current and future users 
in your organization. 

o If you selected Selected teams/users, you can choose Add people or Add team. 
 If you selected Add people, in the "Enable GitHub Copilot access for selected 

members of ORGANIZATION" dialog, you can either search for individual 
members, or you can add members in bulk by uploading a CSV file. 

 If you selected Add team, in the "Enable GitHub Copilot access for selected 
teams of ORGANIZATION" dialog, start typing the team name in the search bar, 
select the team you want to add and click Add team(s) to access list. 

6. To finish setting up your GitHub Copilot for Business subscription, click Save and finish. 
Organization members will receive an email with instructions on how to start using GitHub 
Copilot. 

Installing the GitHub Copilot extension for Visual Studio Code 
To use GitHub Copilot, you must first install the Visual Studio Code extension. 

1. In the Visual Studio Code Marketplace, go to the GitHub Copilot extension page and 
click Install. 

2. A popup will appear, asking to open Visual Studio Code. Click Open Visual Studio Code. 
3. In the "Extension: GitHub Copilot" tab in Visual Studio Code, click Install. 
4. If you have not previously authorized Visual Studio Code in your GitHub account, you will be 

prompted to sign in to GitHub in Visual Studio Code. 
o If you have previously authorized Visual Studio Code in your GitHub account, GitHub 

Copilot will be automatically authorized. 
5. In your browser, GitHub will request the necessary permissions for GitHub Copilot. To approve 

these permissions, click Authorize Visual Studio Code. 
6. In Visual Studio Code, in the "Visual Studio Code" dialogue box, to confirm the authentication, 

click Open. 

Getting your first suggestion 
Note: If you have duplication detection enabled for GitHub Copilot, you may receive limited suggestions, or no suggestions, when using 
the code examples provided. As an alternative, you can start by typing your own code to see suggestions from GitHub Copilot. For more 
information on duplication detection, see "Configuring GitHub Copilot settings on GitHub.com." 
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GitHub Copilot provides suggestions for numerous languages and a wide variety of frameworks, but 
works especially well for Python, JavaScript, TypeScript, Ruby, Go, C# and C++. GitHub Copilot can 
also assist in query generation for databases. The following samples are in JavaScript, but other 
languages will work similarly. 

1. Open Visual Studio Code. 
2. In Visual Studio Code, create a new JavaScript (*.js) file. 
3. In the JavaScript file, type the following function header. 

JavaScript 

function calculateDaysBetweenDates(begin, end) { 

GitHub Copilot will automatically suggest an entire function body in grayed text. The exact 
suggestion may vary. 

4. To accept the suggestion, press Tab. 
 

  



About GitHub Copilot for Individuals 
 

GitHub Copilot can help you code by offering autocomplete-style suggestions. You can learn how GitHub Copilot 
works, and what to consider while using GitHub Copilot. 

About GitHub Copilot 
GitHub Copilot is an AI pair programmer that offers autocomplete-style suggestions as you code. You 
can receive suggestions from GitHub Copilot either by starting to write the code you want to use, or 
by writing a natural language comment describing what you want the code to do. GitHub Copilot 
analyzes the context in the file you are editing, as well as related files, and offers suggestions from 
within your text editor. GitHub Copilot is powered by OpenAI Codex, a new AI system created by 
OpenAI. 

GitHub Copilot is trained on all languages that appear in public repositories. For each language, the 
quality of suggestions you receive may depend on the volume and diversity of training data for that 
language. For example, JavaScript is well-represented in public repositories and is one of GitHub 
Copilot's best supported languages. Languages with less representation in public repositories may 
produce fewer or less robust suggestions. 

GitHub Copilot is available as an extension in Visual Studio Code, Visual Studio, Vim, Neovim and the 
JetBrains suite of IDEs. For more information, see "Getting started with GitHub Copilot." 

Understanding the differences between Copilot for Individuals and Copilot for 
Business 
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For more information about VPN Proxy support via self-signed certificates, see "Configuring GitHub 
Copilot in your environment". 

Using GitHub Copilot 
You can see real-world examples of GitHub Copilot in action. For more information, see the GitHub 
Copilot website. 

GitHub Copilot offers suggestions from a model that OpenAI built from billions of lines of open 
source code. As a result, the training set for GitHub Copilot may contain insecure coding patterns, 
bugs, or references to outdated APIs or idioms. When GitHub Copilot produces suggestions based on 
this training data, those suggestions may also contain undesirable patterns. 

You are responsible for ensuring the security and quality of your code. We recommend you take the 
same precautions when using code generated by GitHub Copilot that you would when using any code 
you didn't write yourself. These precautions include rigorous testing, IP scanning, and tracking for 
security vulnerabilities. GitHub provides a number of features to help you monitor and improve code 
quality, such as GitHub Actions, Dependabot, CodeQL and code scanning. All these features are free 
to use in public repositories. For more information, see "Understanding GitHub Actions" and "GitHub 
security features." 

GitHub Copilot uses filters to block offensive words in the prompts and avoid producing suggestions 
in sensitive contexts. We are committed to constantly improving the filter system to more intelligently 
detect and remove offensive suggestions generated by GitHub Copilot, including biased, 
discriminatory, or abusive outputs. If you see an offensive suggestion generated by GitHub Copilot, 
please report the suggestion directly to copilot-safety@github.com so that we can improve our 
safeguards. 

About billing for GitHub Copilot 
GitHub Copilot is a paid feature, requiring a monthly or yearly subscription. GitHub Copilot 
subscriptions can be paid for and managed through a personal account on GitHub.com with Copilot 
for Individuals, or paid for and managed centrally through an organization account with GitHub 
Copilot for Business. 

Verified students, teachers, and maintainers of popular open source projects on GitHub are eligible to 
use Copilot for Individuals for free. If you meet the criteria for a free Copilot for Individuals 
subscription, you will be automatically notified when you visit the GitHub Copilot subscription page. If 
you do not meet the criteria for a free Copilot for Individuals subscription, you will be offered a 30-
day free trial, after which a paid subscription is required for continued use. For more information, see 
"About billing for GitHub Copilot." 
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About the license for the GitHub Copilot plugin in JetBrains 
IDEs 
GitHub, Inc. is the licensor of the JetBrains plugin. The end user license agreement for this plugin is 
the GitHub Terms for Additional Products and Features and use of this plugin is subject to those 
terms. JetBrains has no responsibility or liability in connection with the plugin or such agreement. By 
using the plugin, you agree to the foregoing terms. 

About privacy for GitHub Copilot for Individuals 
You have the ability to manage and make choices regarding the collection, retention, and processing 
of your data, allowing you to maintain control over your privacy while using GitHub Copilot for 
Individuals. 

What data does GitHub Copilot for Individuals collect? 

GitHub Copilot for Individuals utilizes data from file content and additional sources to enhance its 
functionality. This data collection process is aimed at improving the service and involves the gathering 
and analysis of certain information. 

User Engagement Data 

When you use GitHub Copilot, it collects information about your interactions with the IDE or editor. 
This includes actions like accepting or dismissing suggestions, as well as general usage data and error 
information. The purpose of collecting this data is to measure metrics such as latency and feature 
engagement. Some of this information may include personal data, but it is stored in a way that does 
not directly identify you. 

Prompts 

A Prompt refers to the contextual information that the GitHub Copilot extension sends when you 
pause typing while working on a file, or when you open the GitHub Copilot pane. These Prompts are 
only sent in real time unless you have chosen to enable telemetry collection, in which case they are 
retained. 

Suggestions 

After receiving and processing a Prompt, the AI-model generates one or more lines of proposed text 
known as Suggestions. These Suggestions are then transmitted back to the GitHub Copilot extension. 
By default, Suggestions are only sent in real time. However, if you have enabled telemetry collection, 
GitHub Copilot retains these Suggestions. 
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How is the data in GitHub Copilot for Individuals used and shared? 

User Engagement Data, Prompts and Suggestions are used by GitHub and Microsoft to improve 
GitHub Copilot and related services and to conduct product and academic research. 

• Enhancing GitHub Copilot: The data collected is utilized to improve GitHub Copilot by evaluating 
different strategies for processing and predicting suggestions that users may find valuable. 

• Developing related developer products and services: The insights gained from the data help in the 
development and improvement of other developer tools and services offered by GitHub and Microsoft. 

• Detecting abuse and policy violations: The data is examined to investigate and identify any potential 
misuse or violation of the Acceptable Use Policies associated with GitHub Copilot. 

• Conducting experiments and research: The data is used for conducting experiments and research 
related to developers and their utilization of developer tools and services. This aids in gaining valuable 
insights into user behavior and preferences. 

• Evaluating GitHub Copilot: The impact of GitHub Copilot on users is assessed by measuring its positive 
effects and benefits. 

• Improving code generation models: The collected data is employed to refine and enhance the 
underlying models responsible for generating code. This is achieved by utilizing both positive and 
negative examples. 

• Fine-tuning ranking and sorting algorithms: The data helps in the optimization and improvement of 
algorithms used for ranking and sorting suggestions, thereby enhancing the overall user experience. 

How is the transmitted Code Snippets data protected? 

To ensure the protection of sensitive data such as user edit actions, source code snippets, and 
repository URLs/file paths, several protective measures are implemented. These measures include: 

• Encryption of transmitted data: All data is encrypted both during transit and while at rest, ensuring that 
it remains secure and inaccessible to unauthorized parties. 

• Strict access control: Access to the data is tightly regulated and limited to specific individuals, including: 
o Named GitHub personnel working on the GitHub Copilot team or the GitHub platform health 

team. 
o Microsoft personnel involved with the GitHub Copilot team. 

• Role-based access controls and multi-factor authentication: People who require access to code snippet 
data must adhere to role-based access controls. Additionally, multi-factor authentication is 
implemented to add an extra layer of security, ensuring that only authorized individuals can access the 
data. 

How can users of GitHub Copilot for Individuals control use of their Code 
Snippets Data? 

GitHub Copilot gives you choices about how it uses the data it collects. 
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• User Engagement Data: User Engagement Data, including pseudonymous identifiers and general usage 
data, is necessary for the proper functioning of GitHub Copilot. This data is collected, processed, and 
shared with Microsoft while you use GitHub Copilot. 

• Retention of Prompts and Suggestions: You have the option to decide whether Prompts and 
Suggestions are retained by GitHub and shared with Microsoft. These preferences can be adjusted in 
the GitHub Copilot settings. 

• Requesting Deletion: If you wish to delete Prompts and Suggestions associated with your GitHub 
identity, contact GitHub Support. 

Will my private code be shared with other users? 

No. We follow responsible practices in accordance with our Privacy Statement to ensure that your 
code snippets will not be used as suggested code for other users of GitHub Copilot. 
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Getting started with GitHub Copilot 
You can start using GitHub Copilot by installing the extension in your preferred environment. 

JetBrains IDEs (Beta)Vim/NeovimVisual StudioVisual Studio Code 
 
GitHub Copilot can be managed through personal accounts with GitHub Copilot for Individuals or through 
organization accounts with GitHub Copilot for Business. 
 
GitHub Copilot is free to use for verified students, teachers, and maintainers of popular open source projects. If 
you are not a student, teacher, or maintainer of a popular open source project, you can try GitHub Copilot for 
free with a one-time 30-day trial. After the free trial, you will need a paid subscription for continued use. For 
more information, see "About billing for GitHub Copilot." 

About GitHub Copilot and JetBrains IDEs 
GitHub Copilot provides autocomplete-style suggestions from an AI pair programmer as you code. 
For more information, see "About GitHub Copilot for Individuals". 

If you use a JetBrains IDE, you can view and incorporate suggestions from GitHub Copilot directly 
within the editor. This guide demonstrates how to use GitHub Copilot within a JetBrains IDE for 
macOS, Windows, or Linux. 

Prerequisites 
• To use GitHub Copilot you must have an active GitHub Copilot subscription. For more 

information, see "About billing for GitHub Copilot." 

• To use GitHub Copilot in JetBrains, you must have a compatible JetBrains IDE installed. GitHub 
Copilot is compatible with the following IDEs: 

o IntelliJ IDEA (Ultimate, Community, Educational) 
o Android Studio 
o AppCode 
o CLion 
o Code With Me Guest 
o DataGrip 
o DataSpell 
o GoLand 
o JetBrains Client 
o MPS 
o PhpStorm 
o PyCharm (Professional, Community, Educational) 
o Rider 
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o RubyMine 
o WebStorm 

For more information, see the JetBrains IDEs tool finder. 

Installing the GitHub Copilot extension in your JetBrains IDE 
To use GitHub Copilot in a JetBrains IDE, you must install the GitHub Copilot extension. The following 
procedure will guide you through installation of the GitHub Copilot plugin in IntelliJ IDEA. Steps to 
install the plugin in another supported IDE may differ. 

1. In your JetBrains IDE, under the File menu for Windows or under the name of your IDE for Mac 
(for example, PyCharm or IntelliJ), click Settings for Windows or Preferences for Mac. 

2. In the left-side menu of the Settings/Preferences dialog box, click Plugins. 
3. At the top of the Settings/Preferences dialog box, click Marketplace. In the search bar, search 

for GitHub Copilot, then click Install. 

 

4. After GitHub Copilot is installed, click Restart IDE. 
5. After your JetBrains IDE has restarted, click the Tools menu. Click GitHub Copilot, then 

click Login to GitHub. 

https://www.jetbrains.com/products/
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6. In the "Sign in to GitHub" dialog box, to copy the device code and open the device activation 
window, click Copy and Open. 

 

7. A device activation window will open in your browser. Paste the device code, then 
click Continue. 

8. GitHub will request the necessary permissions for GitHub Copilot. To approve these 
permissions, click Authorize GitHub Copilot Plugin. 

9. After the permissions have been approved, your JetBrains IDE will show a confirmation. To 
begin using GitHub Copilot, click OK. 

Seeing your first suggestion 
Note: If you have duplication detection enabled for GitHub Copilot, you may receive limited suggestions, or no suggestions, when using 
the code examples provided. As an alternative, you can start by typing your own code to see suggestions from GitHub Copilot. For more 
information on duplication detection, see "Configuring GitHub Copilot settings on GitHub.com." 

GitHub Copilot provides suggestions for numerous languages and a wide variety of frameworks, but 
works especially well for Python, JavaScript, TypeScript, Ruby, Go, C# and C++. GitHub Copilot can 
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also assist in query generation for databases. The following samples are in Java, but other languages 
will work similarly. 

1. In your JetBrains IDE, create a new Java (*.java) file. 
2. In the Java file, create a class by typing class Test. GitHub Copilot will automatically suggest a 

class body in grayed text. The exact suggestion may vary. 
3. To accept the suggestion, press Tab. 
4. To prompt GitHub Copilot to suggest a function body, type the following line below the 

bracket of the main function. The exact suggestion may vary. 

Java 

int calculateDaysBetweenDates( 

5. To accept the suggestion, press Tab. 

GitHub Copilot will attempt to match the context and style of your code. You can always edit the 
suggested code. 

Seeing alternative suggestions 

For any given input, GitHub Copilot may offer multiple suggestions. You can select which suggestion 
to use, or reject all suggestions. 

1. In your JetBrains IDE, create a new Java (*.java) file. 
2. To prompt GitHub Copilot to show you a suggestion, type the following line in the Java file. 

Java 

int calculateDaysBetweenDates( 
3. Optionally, you can see alternative suggestions, if any are available. 

OS See next suggestion See previous suggestion 

macOS Option+] Option+[ 

Windows Alt+] Alt+[ 
Linux Alt+] Alt+[ 

4. To accept a suggestion, press Tab. To reject all suggestions, press Esc. 

Seeing multiple suggestions in a new tab 

You may not want any of the initial suggestions GitHub Copilot offers. You can use a keyboard 
shortcut to prompt GitHub Copilot to show you multiple suggestions in a new tab. 

1. In your JetBrains IDE, create a new Java (*.java) file. 
2. To prompt GitHub Copilot to show you a suggestion, type the following line in the Java file. 

Java 
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int calculateDaysBetweenDates( 
3. Open a new tab with multiple additional suggestions. 

o On macOS, press Command+Shift+A, then click Open GitHub Copilot, or 
press Command+Shift+\ to open the new tab immediately. 

o On Windows or Linux, press Ctrl+Enter, then click Open GitHub Copilot. 
4. To accept a suggestion, above the suggestion, click Accept Solution. To reject all suggestions, 

close the tab. 

Generating code suggestions from comments 
You can describe something you want to do using natural language within a comment, and GitHub 
Copilot will suggest the code to accomplish your goal. 

1. In your JetBrains IDE, create a new Java (*.java) file. 
2. To prompt GitHub Copilot to suggest an implementation of a function in the Java file, type the 

following lines. 
Java 

// find all images without alternate text 
// and give them a red border 
void process () { 

Enabling and disabling GitHub Copilot 
You can enable or disable GitHub Copilot for all languages, or for individual languages. The GitHub 
Copilot status icon in the bottom panel of your JetBrains IDE window indicates whether GitHub 
Copilot is enabled or disabled. When enabled, the icon is highlighted. When disabled, the icon is 
grayed out. 

1. To enable or disable GitHub Copilot, click the status icon in the bottom panel of the JetBrains 
window. 

 

2. If you are disabling GitHub Copilot, you will be asked whether you want to disable it 
globally, or for the language of the file you are currently editing. 

o To disable suggestions from GitHub Copilot globally, click Disable Completions. 
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o To disable suggestions from GitHub Copilot for the specified language, click Disable 
Completions for LANGUAGE. 

 

  



Configuring GitHub Copilot settings on 
GitHub.com 

 

You can configure GitHub Copilot's behavior on GitHub.com, which affects how GitHub Copilot functions in any IDE 
that you use. 

Who can use this feature 

People with individual GitHub Copilot subscriptions can configure their settings on GitHub.com. 

GitHub Copilot can be managed through personal accounts with GitHub Copilot for Individuals or through 
organization accounts with GitHub Copilot for Business. 
 
GitHub Copilot is free to use for verified students, teachers, and maintainers of popular open source projects. If you 
are not a student, teacher, or maintainer of a popular open source project, you can try GitHub Copilot for free with a 
one-time 30-day trial. After the free trial, you will need a paid subscription for continued use. For more information, 
see "About billing for GitHub Copilot." 
 

About GitHub Copilot settings on GitHub.com 
In addition to the configuration for the GitHub Copilot plugin in your supported IDE, you can 
configure settings for GitHub Copilot on GitHub.com. The settings apply wherever you use GitHub 
Copilot. 

Configuring GitHub Copilot settings on GitHub.com 
Once you have an active GitHub Copilot trial or subscription, you can adjust GitHub Copilot settings 
for your personal account on GitHub in the GitHub Copilot settings. The settings apply anywhere that 
you use GitHub Copilot. You can configure the suggestions that GitHub Copilot offers and how 
GitHub uses your telemetry data. 

Enabling or disabling duplication detection 

Note: If you are a member of an organization on GitHub Enterprise Cloud who has been assigned a GitHub Copilot seat through your 
organization, you will not be able to configure duplication detection in your personal account settings. Your duplication detection 
setting will be inherited from your organization or enterprise. 
GitHub Copilot includes a filter which detects code suggestions matching public code on GitHub. You 
can choose to enable or disable the filter. When the filter is enabled, GitHub Copilot checks code 
suggestions with their surrounding code of about 150 characters against public code on GitHub. If 
there is a match or near match, the suggestion will not be shown to you. 

1. In the upper-right corner of any page, click your profile photo, then click Settings. 
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2. In the left sidebar, click  GitHub Copilot. 
3. Under Suggestions matching public code, select the dropdown menu, then click Allow to 

allow suggestions matching public code, or Block to block suggestions matching public code. 
4. To confirm your new settings, click Save. 

Enabling or disabling code snippet collection 

Note: Copilot for Business does not retain any Prompts or Suggestions. 
You can choose whether your Prompts and Suggestions are collected and retained by GitHub and 
further processed and shared with Microsoft and by adjusting your user settings. For more 
information about data that GitHub Copilot may collect depending on your telemetry settings, see 
"GitHub Terms for Additional Products and Features" and the GitHub Copilot privacy FAQ. 

1. In the upper-right corner of any page, click your profile photo, then click Settings. 

https://docs.github.com/en/copilot/configuring-github-copilot/configuring-github-copilot-settings-on-githubcom#enabling-or-disabling-code-snippet-collection
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2. In the left sidebar, click  GitHub Copilot. 
3. To allow or prevent GitHub using your telemetry data, select or deselect Allow GitHub to use 

my code snippets for product improvements. 
4. To confirm your new settings, click Save. 

 

  



Configuring GitHub Copilot in your 
environment 

 

You can enable, configure, or disable GitHub Copilot in a supported IDE. 

JetBrains IDEs (Beta)Vim/NeovimVisual StudioVisual Studio Code 

GitHub Copilot can be managed through personal accounts with GitHub Copilot for Individuals or through 
organization accounts with GitHub Copilot for Business. 
 
GitHub Copilot is free to use for verified students, teachers, and maintainers of popular open source projects. If you 
are not a student, teacher, or maintainer of a popular open source project, you can try GitHub Copilot for free with a 
one-time 30-day trial. After the free trial, you will need a paid subscription for continued use. For more information, 
see "About billing for GitHub Copilot." 

About GitHub Copilot in JetBrains IDEs 
If you use a JetBrains IDE, GitHub Copilot can autocomplete code as you type. After installation, you 
can enable or disable GitHub Copilot, and you can configure advanced settings within your IDE or on 
GitHub.com. This article describes how to configure GitHub Copilot in the IntelliJ IDE, but the user 
interfaces of other JetBrains IDEs may differ. 

Prerequisites 

To configure GitHub Copilot in a JetBrains IDE, you must install the GitHub Copilot plugin. For more 
information, see "Getting started with GitHub Copilot." 

Using or rebinding keyboard shortcuts for GitHub Copilot 
You can use the default keyboard shortcuts for inline suggestions in your JetBrains IDE when using 
GitHub Copilot. Alternatively, you can rebind the shortcuts to your preferred keyboard shortcuts for 
each specific command. For more information on rebinding keyboard shortcuts in your JetBrains IDE, 
see the JetBrains documentation. For example, you can view the IntelliJ IDEA documentation. 

Keyboard shortcuts for macOS 

Ac�on Shortcut 

Accept an inline sugges�on Tab 

Dismiss an inline sugges�on Esc 
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Ac�on Shortcut 

Show next inline sugges�on Option (⌥) or Alt+] 

Show previous inline sugges�on Option (⌥) or Alt+[ 

Trigger inline sugges�on Option (⌥)+\ 

Open GitHub Copilot (addi�onal sugges�ons in separate pane) Option (⌥) or Alt+Return 

Keyboard shortcuts for Windows 

Ac�on Shortcut 

Accept an inline sugges�on Tab 

Dismiss an inline sugges�on Esc 

Show next inline sugges�on Alt+] 

Show previous inline sugges�on Alt+[ 

Trigger inline sugges�on Alt+\ 

Open GitHub Copilot (addi�onal sugges�ons in separate pane) Alt+Enter 

Keyboard shortcuts for Linux 

Ac�on Shortcut 

Accept an inline sugges�on Tab 

Dismiss an inline sugges�on Esc 

Show next inline sugges�on Alt+] 

Show previous inline sugges�on Alt+[ 

Trigger inline sugges�on Alt+\ 

Open GitHub Copilot (addi�onal sugges�ons in separate pane) Alt+Enter 

Enabling or disabling GitHub Copilot 
You can enable or disable GitHub Copilot from within your JetBrains IDE. The GitHub Copilot status 
icon in the bottom panel of the JetBrains window indicates whether GitHub Copilot is enabled or 
disabled. When enabled, the icon is highlighted. When disabled, the icon is grayed out. 

https://docs.github.com/en/copilot/configuring-github-copilot/configuring-github-copilot-in-your-environment#keyboard-shortcuts-for-windows
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1. To enable or disable GitHub Copilot, click the status icon in the bottom panel on the right of 
the JetBrains window. 

 

2. If you are disabling GitHub Copilot, you will be asked whether you want to disable it globally, 
or for the language of the file you are currently editing. To disable globally, click Disable 
Completions. Alternatively, click the language-specific button to disable GitHub Copilot for the 
specified language. 

 

Configuring advanced settings for GitHub Copilot 
You can manage advanced settings for GitHub Copilot in your JetBrains IDE, such as how your IDE 
displays code completions, and which languages you want to enable or disable for GitHub Copilot. 

1. In your JetBrains IDE, click the File menu, then click Settings. 
2. Under Languages & Frameworks, click GitHub Copilot. 
3. Edit the settings according to your personal preferences. 

o To adjust the behavior and appearance of code suggestions, and whether to automatically check 
for updates, select or deselect the corresponding checkboxes. 

o If you have selected to receive automatic updates, you can choose whether to receive stable, but 
less frequent updates, or nightly updates, which may be less stable. Click the Update 
channel dropdown and select Stable for stable updates, or Nightly for nightly updates. 

o Under "Disabled languages," use the checkboxes to select or deselect the languages you want 
to disable GitHub Copilot for. 

Configuring proxy settings for GitHub Copilot 
You can configure GitHub Copilot to connect through an HTTP proxy server in a JetBrains IDE. GitHub 
Copilot supports basic HTTP proxy setups, with or without basic authentication. 

1. In your JetBrains IDE, click the File menu, then click Settings. 
2. Under Appearance & Behavior, click System Settings and then click HTTP Proxy. 
3. Select Manual proxy configuration, and then select HTTP. 
4. In the "Host name" field, enter the hostname of your proxy server, and in the "Port number" field, enter 

the port number of your proxy server. 

https://docs.github.com/en/copilot/configuring-github-copilot/configuring-github-copilot-in-your-environment#configuring-advanced-settings-for-github-copilot
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5. Optionally, in the left sidebar, click Tools and then click Server Certificates. Then select or 
deselect Accept non-trusted certificates automatically, depending on whether you want to accept 
non-trusted certificates automatically. 

Configuring GitHub Copilot settings on GitHub.com 

Once you have an active GitHub Copilot trial or subscription, you can adjust GitHub Copilot settings 
for your personal account on GitHub in the GitHub Copilot settings. The settings apply anywhere that 
you use GitHub Copilot. You can configure the suggestions that GitHub Copilot offers and how 
GitHub uses your telemetry data. 

Enabling or disabling duplication detection 

Note: If you are a member of an organization on GitHub Enterprise Cloud who has been assigned a GitHub Copilot seat through your 
organization, you will not be able to configure duplication detection in your personal account settings. Your duplication detection 
setting will be inherited from your organization or enterprise. 

GitHub Copilot includes a filter which detects code suggestions matching public code on GitHub. You 
can choose to enable or disable the filter. When the filter is enabled, GitHub Copilot checks code 
suggestions with their surrounding code of about 150 characters against public code on GitHub. If 
there is a match or near match, the suggestion will not be shown to you. 

1. In the upper-right corner of any page, click your profile photo, then click Settings. 

 

2. In the left sidebar, click  GitHub Copilot. 
3. Under Suggestions matching public code, select the dropdown menu, then click Allow to 

allow suggestions matching public code, or Block to block suggestions matching public code. 

https://docs.github.com/en/copilot/configuring-github-copilot/configuring-github-copilot-in-your-environment#configuring-github-copilot-settings-on-githubcom
https://github.com/settings/copilot
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4. To confirm your new settings, click Save. 

Enabling or disabling code snippet collection 

Note: Copilot for Business does not retain any Prompts or Suggestions. 

You can choose whether your Prompts and Suggestions are collected and retained by GitHub and 
further processed and shared with Microsoft and by adjusting your user settings. For more 
information about data that GitHub Copilot may collect depending on your telemetry settings, see 
"GitHub Terms for Additional Products and Features" and the GitHub Copilot privacy FAQ. 

1. In the upper-right corner of any page, click your profile photo, then click Settings. 

 

2. In the left sidebar, click  GitHub Copilot. 
3. To allow or prevent GitHub using your telemetry data, select or deselect Allow GitHub to use 

my code snippets for product improvements. 
4. To confirm your new settings, click Save. 
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